Tutorial 2. Flow Past a Circular Cylinder – Two Dimensional Case

Refined Mesh

Using ANSYS Workbench

As a continuation of Tutorial 1, the student will create a refined mesh around the cylinder while keeping a coarse mesh near the walls, inlet and outlet. In addition, changes in the convergence criteria are made and the results of these changes (mesh and convergence criteria) are compared to the results obtained with the mesh created in Tutorial 1 and also with experimental results.
Tutorial 2 deals with the same problem Tutorial 1 does, with the difference that we will learn to create a refined mesh. The initial steps are just the same as in the previous tutorial.

1. Starting ANSYS Workbench
   - Click on the Start Menu, and then select Workbench 14.0.
   - Close Getting Started window.
   - Left click on the tab corresponding to FluidFlow (FLUENT) and without releasing the mouse button drag the icon to the Project Schematic window (central big window).
   - Click twice on the lower tab and rename the project to Cylinder1

   ![Image of ANSYS Workbench interface]

   - Now left click once on the Geometry tab, the information on the Properties of Schematic window will change. Change the Analysis Type under the Advanced Geometry Options from 3D to 2D.
   - Back to the Project Schematic Window, click twice on the Geometry tab. This action will launch ANSYS Design Modeler (green logo DM).

2. Create Geometry
   - Set units to centimeters (cm) and click ok.
   - Right click on icon corresponding to XYPlane and select look at.
   - Down below the Tree Outline window you will see the Sketching and Modeling tabs. Select the Sketching tab.
   - A Sketching Toolboxes window will replace the Tree Outline window with a new set of tabs, select the Settings tab.
   - Select Grid and activate the buttons Show in 2D and Snap.
   - Make sure that Major Grid Spacing is set to 5 cm, Minor–Steps per Major is 5, and Snaps per Minor is 1.
Click on the icon corresponding to **New Sketch** to create **Sketch 1**. Click twice again on the icon to create **Sketch 2** and **Sketch 3**. Click on the **Modeling** tab and you will notice that you have created **Sketch 1**, **Sketch 2** and **Sketch 3**.

- Click on **Sketch 1** and then click on the **Sketching** tab.
- Select the **Draw** tab and choose **circle**. Draw a circle with center at the origin (at this point the size of the circle is not important, it will be adjusted in the next step), and then click on **Generate**.
- Once the circle has been created select the tab corresponding to **Dimensions** and choose **Radius**. Left click on the circle you just drew and drag the mouse outwards without releasing the mouse button until you see an arrow indicating the radius of the circle, then release button.
- On the new window that appears (**Details View** window) adjust the radius to 2 cm, and click on **Generate**.
- Select now **Sketch 2** and click on the **Draw** tab. Choose **Rectangle**. Then create a rectangle with vertices (-30, 20) and (50, -20). Click on **Generate** to create this entity.
- Now go to the **Concept** tab and select **Surfaces From Sketches**.
• Use the `Ctrl` key select **Sketch 1** and **Sketch 2**. The rectangle and the circle must become yellow. Click on **Apply** on the **Details View** window. The circle and the rectangle will become cyan.
• Now, click on **Generate**. You have created a circular and a rectangular surface.

The next step consists in subtracting the circle from the rectangle so we create the geometry that we will use to generate our mesh. Click on the **Create** tab and select **Boolean**.

In the **Details** window, select the **Operation** tab and choose **Subtract**. Click on the **Target Bodies** tab. Going back up to the **Tree Outline** window, under **2 Parts, 2 Bodies**. Select the **Surface Body** tab that highlights yellow the rectangle. Then click **Apply**. The rectangle will become cyan.

Now click on **Tool Bodies**, select the **Surface Body** tab that highlights yellow the circle and click **Apply**. The circle will become cyan. Make sure that the tab corresponding to **Preserve Tool Bodies?** Is set **No**. Click on **Generate**.

Now we are going to create a square that will help us to refine our mesh around the cylinder. Select **Sketch 3** and create a rectangle with vertices (-10,10) and (10, -10). Click **Generate**.

This rectangle is still a sketch, we are going to transform it into a set of four lines by selecting **Concept** and **Lines From Sketches**.

On the **Tree Outline** select **Sketch 3** and then click on **Apply** on the **Details View** window. Click on **Generate**.

Now we have a surface area that contains the rectangle with a circular bore with radius of 2 cm, and a set of four lines, these are two separate entities; we need to make them a single set by having the surface area and the four lines in the same entity.
• From the Tools tab, select **Projection**. Using the **Selection Filter: Edges** tool and the Ctrl key select the four sides of the rectangle, then click **Apply** on the Details View window (**Details of projection**). The sides of the rectangle must become cyan.

• Now, **Edges** tab must indicate 4. And the tab underneath (**Target**) must be yellow. Click on it to activate it and then place the mouse over the grey rectangle, the selection tool must have changed to **Selection Filter: Model Faces** automatically. Click on the rectangle to select it, it will become green. Then click on **Apply** and finally on **Generate**. Now the lines and the surface belong to the same set. Our geometry is almost ready to be meshed. As in the previous exercise, we need to specify the inlet, the outlet, the walls and the cylinder.

• On the upper tools bar, select the icon corresponding to **Selection Filter: Edges**.
• Place the mouse near the left end of the rectangle and left click to highlight it (green). Once it is green right click to select **Named Selection**. Then click on **Apply**, and finally on **Generate**. Right click on the new entity created, **NamedSel1**, and choose **Rename**. Type **Inlet** and hit enter.

• Follow same procedure for the right end of the rectangle to define the outlet. Place the mouse near the right end of the rectangle; left click to highlight it (green). Then right click to select **Named Selection**. Then click on **Apply**, and finally on **Generate**. Right click on the new entity created, **NamedSel2**, and choose **Rename**. Type **Outlet** and hit enter.

• Finally we follow the same procedure to create the cylinder. Always using the **Selection Filter: Edges** took, left click on the circle to highlight it on green, then right click to choose **Named Selection**, click on **Apply**, click on **Generate** and rename it to be **Cylinder**.

• Click on the **Save Project** icon to save your work. Close DM and go back to the Workbench.

### 3. Mesh Generation

• On your Ansys Workbench, double click on the tab corresponding to mesh.

• It will take few seconds to load and once it has loaded you might get an error message, just click **OK** and go to the meshing software (M).

• Once you are on the meshing software your view should be similar to the view shown next.
• In the Outline window, under Project, right click on Mesh to open a menu as shown in the figure. Select Insert and click on Mapped Face Meshing.

• A Details of “Mapped Face Meshing” will open under the Outline window and the mouse will change automatically to Selection Filter: Model Faces. Select the two rectangles, they will become green and then click on Apply on the Details of “Mapped Face Meshing” window. This window will indicate that you have selected 2 Faces, and your selection will have become purple. Now click on Update. This step ensures us that when proceeding with the meshing, all the elements will be Quadrilaterals (having four sides).

• Again, in the Outline window, under Project, right click on Mesh. Select Insert and click on Sizing.

• Change the cursor from Selection Filter: Model Faces to Selection Filter: Edges and using the Ctrl key select the four sides of the inner rectangle. They will become green.

• Then click on Apply, the four sides will become purple and you will see that the geometry tab indicates that 4 Edges have been selected.

• Change the Type from the default Element Size to Number of Divisions. Set the Number of Divisions equal to 40. And change the Behavior from Soft to Hard. Then click on Update.

• Finally, in the Details of Mesh window, under Project, click on the plus sign next to Sizing to expand this tab and then change Relevance Center from Coarse to Fine.

• Click on Update.

• Close the window.

• Save your work on the Workbench.
4. Setting up Physics and Solution of the Problem using Fluent

- Double click on the Setup tab, and then click OK on the Fluent Launcher window.
- Once Fluent opens you will see the mesh you just created displayed on the central window.

- On the left side you will see a menu showing three main sections: Problem Setup, Solution, and Results. Let’s start by setting up our problem.
- Activate the gravity effects by checking the button next to Gravity. Set Gravitational Acceleration equal to -9.81 on the section corresponding to Y–direction.
- Select the tab corresponding to Units… under Quantities select Length and set it to cm. Then click Close.
- Next, click on Models and make sure that the everything on the Models window is off except the third option corresponding to viscous; this must be Viscous–Laminar.
- Next, click on Materials, highlighting the option corresponding to Fluid, click on Create/Edit. Select Fluent Data Base on the window that opened. Select Water–Liquid (h2o<l>). Click on Copy, and then Close. Also close the Create/ Edit Materials window.
- Now click on the Cell Zone Conditions tab and click on the Edit… button. Change the Material Name from air to water–liquid. Click OK.
- Now we input the boundary conditions. Select Inlet and click on Edit. Set the Magnitude of the Velocity (m/s) to 0.0003. Click OK.
- On the outlet make sure that the Type is set to pressure-outlet. Clock on Edit… and make sure that the Gauge Pressure (pascal) is 0. Click OK.
- Make sure that cylinder and wall-surface_body are defined as Type wall.
- Under Solution, select Solution Initialization and click on Initialize.
- Go to Run Calculation, set Number of Iterations to 1000, Reporting Interval to 10 and click on Calculate.
- Once the solution has converged we proceed to review the results. Under the Results section click on Graphics and Animations.
- On the window that gets activated select Contours and Set Up.
- A new window will open, select the option Filled, and select Contours of Velocity with the option Velocity Magnitude. Then click on Display.
• Now still under the Graphics option select Vectors, then click on Display.
• A number of parameters are available through the contour plots, in our case, pressure is also a relevant parameter.
• Finally we can determine the drag exerted by the fluid on the cylinder using the Reports section under Results. Click on Reports, select Forces and press the Set Up ... button. Select only the Wall Zone corresponding to Cylinder by highlighting it. Click on Print. A print out with all the forces acting on the cylinder will be shown in the command window.

### Forces

<table>
<thead>
<tr>
<th>Zone</th>
<th>Forces (n)</th>
<th>%</th>
<th>%</th>
<th>%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cylinder</td>
<td>Pressure</td>
<td>(2.9852542e-06 1.8692665e-09 0)</td>
<td>(2.9852542e-06 1.8692665e-09 0)</td>
<td>(6.095229e-06 1.858989e-07 0)</td>
</tr>
<tr>
<td>Net</td>
<td>Pressure</td>
<td>(2.9852542e-06 1.8692665e-09 0)</td>
<td>(2.9852542e-06 1.8692665e-09 0)</td>
<td>(6.095229e-06 1.858989e-07 0)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Zone</th>
<th>Forces (n)</th>
<th>%</th>
<th>%</th>
<th>%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cylinder</td>
<td></td>
<td>(2.999988e-06 1.8482918e-07 0)</td>
<td>(2.999988e-06 1.8482918e-07 0)</td>
<td>(6.084896e-06 1.858984e-07 0)</td>
</tr>
<tr>
<td>Net</td>
<td></td>
<td>(2.999988e-06 1.8482918e-07 0)</td>
<td>(2.999988e-06 1.8482918e-07 0)</td>
<td>(6.084896e-06 1.858984e-07 0)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Zone</th>
<th>Forces (n)</th>
<th>%</th>
<th>%</th>
<th>%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cylinder</td>
<td></td>
<td>(2.999988e-06 1e-10 0)</td>
<td>(2.999988e-06 1e-10 0)</td>
<td>(6.084896e-06 1.858984e-07 0)</td>
</tr>
<tr>
<td>Net</td>
<td></td>
<td>(2.999988e-06 1e-10 0)</td>
<td>(2.999988e-06 1e-10 0)</td>
<td>(6.084896e-06 1.858984e-07 0)</td>
</tr>
</tbody>
</table>

### Forces - Direction Vector (1 0 0)

<table>
<thead>
<tr>
<th>Zone</th>
<th>Forces (n)</th>
<th>%</th>
<th>%</th>
<th>%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cylinder</td>
<td></td>
<td>(3.999988e-06 1e-10 0)</td>
<td>(3.999988e-06 1e-10 0)</td>
<td>(6.084896e-06 1.858984e-07 0)</td>
</tr>
<tr>
<td>Net</td>
<td></td>
<td>(3.999988e-06 1e-10 0)</td>
<td>(3.999988e-06 1e-10 0)</td>
<td>(6.084896e-06 1.858984e-07 0)</td>
</tr>
</tbody>
</table>

• Now go back to the Boundary Conditions and select wall-surface_body. Change the Type to Symmetry and accept on the two windows that will open.
• Initialize the problem again and Run Calculation.
• What differences do you find in the velocity and pressure contours?
• What is the $C_D$ now?
• Finally, let’s adjust the convergence criteria to obtain results that are compatible with experimental data. Under Solution, select Monitors and then highlight Residuals – Print, Plot and click on Edit... Change the convergence criteria for Continuity, x-velocity, and y-velocity to 0.00001 (all three cases). Click on OK. Initialize and then Run Calculation.